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About This Guide 
his guide was developed for those who want to design, plan, implement, 
support, and use an information management or print-on-demand solution 
built on the UltraWare Application Suite. 

This reference assumes knowledge of the fundamentals of the Microsoft Windows 
family of operating systems including Windows 9x/ME, Windows NT, Windows 
2000, and Windows XP. 

N O T A T I O N A L  C O N V E N T I O N S  
� Characters or commands that you type appear in bold lowercase type. 

� Placeholders for variable information appear in italic. 

� File and folder names appear in Title Caps. Filename extensions appear in all 
lowercase. 

� Acronyms appear in all uppercase. 

� Monospace type represents code samples, examples of screen text, or entries 
you type at a command prompt. 

 

Several types of notes and other specific information appear 
throughout this guide. A specific icon marks each type of 
information. The definition of each icon and the type of 
information represented appears in the table at left. 

T 

I C O N  K E Y  

* Tip/Hint 

L Information 

0 Warning 
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Custom Print Interface 
Alto Imaging Technologies’ Custom Print Interface provides advanced printing from 
UltraWare applications to the Canon iR110 or Heidelberg Digimaster 9110 marking 
engine. With Custom Print, and through the use of Kodak Graphics Language (KGL) 
headers, image data can be written directly to the System Control Subsystem (SCS) 
spool directory, bypassing page definition language interpretation. The KGL header 
alone is quickly interpreted, and makes reference to the image files that are then passed 
directly to the marking engine.  

The implementation of KGL headers is simple. A PostScript like header including 
KGL document structuring conventions is submitted through standard LPR printing 
requests. The header includes lines referencing the image data written to the SCS. 
These images may be written to the SCS via File Transfer Protocol (FTP) or by 
mounting a network drive via the Novell RPrinter implementation over IPX/SPX, or 
Network File System (NFS) over TCP/IP. Once the images are in position and the 
header is submitted, the result is extremely fast processing and output. 

Figure 1 demonstrates how an UltraWare direct printing application places images in a 
print ready format onto a shared mount point between the Window 2000 based Scan 
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Station/Image Server, and the Solaris platform residing on the SCS. The printing 
process begins after a KGL header, based on the features selected from the printing 
interface, is submitted. 

The Custom Print interface (Figure 2) supports paper exceptions with mixed plex-
mode, full stapling/stacker functionality, bookmaker modes, and collate/non-collate 
modes. Output may be directed to multiple destinations from a single print job. 
Set/Chapter control allows complex finishing such as multiple subset stapling. Support 

for printer definition and printing to an unlimited number of marking engines from a 
single user interface is provided. Proof Mode, Trailer page behavior, and Cover mode 
are all selectable from the user interface. 

Custom Print includes the most requested capabilities available allowing you to easily 
put the Canon iR110 or Heidelberg Digimaster 9110 marking engine into a production 
environment. 

F I G U R E  2  
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Support for other PostScript compatible printers is available through the Custom Print 
Common user interface (Figure 3) and provides many of the same capabilities found in 
the traditional Custom Print interface. 

 
Actual capabilities available in the Custom Print Common interface are 
dependent on those features available from the print driver and reported 
through the application programming interface (API). 

F I G U R E  3  
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Configuring the Custom Print Interface 
Configuration for Custom Print Common is not required. Print drivers 
available to the installed operating system will be available from the Custom 
Print interface. 

For Custom Print via a network volume, map a drive to the SCS SYS 
volume if using IPX/SPX (Novell), or to /var/spool if using NFS over 
TCP/IP 

1. Click Start, point to Programs, point to Alto Imaging UltraWare, and then 
select Arranger. 

The configuration may also be completed from UltraPrint Client. After 
highlighting a book, select File from the menu bar, point to Custom Print, 
and then click Digimaster 9110 Custom Print. 

2. Click the File menu, and then click Open… 

3. Select an image file, and then click Open. 

4. Click the File menu, point to Custom Print, and then select Digimaster 9110 
Custom Print. 

The Digimaster 9110 Advanced Settings dialog box appears, as illustrated in 
Figure 4. 

5. Click More in the Print Settings section. 

The Printer Settings dialog box appears, as illustrated in Figure 5. 

6. Enter the Image Path to the SCS. 

� For printing via FTP (where ip_addr is equal to the IP address for 
the SCS):  

ftp:\\ip_addr\var\spool\drop_box\images 

� For printing via a network volume (where drive_letter is equal to 
the mapped drive): 

drive_letter:\drop_box\images\ (include trailing slash) 

For printing via a network volume, skip to step 9 

 

L 

L 

* 



C U S T O M  P R I N T  U S E R  G U I D E  

5 

7. Click Login. 

The FTP Login dialog box appears as illustrated in Figure 6. 

8. Enter the User ID and Password for the root account, and then click OK. 

9. Edit the LPR String, replacing 0.0.0.0 with the IP address for the SCS 
(default queue name is DM9110 or IR110). 

10. Enter the path to the Paper Catalog. 

� For printing via FTP (where ip_addr is equal to the IP address for 
the SCS):  

ftp:\\ip_addr\var\spool\drop_box\def_media_catalog.mc 

F I G U R E  4  
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� For printing via a network volume (where drive_letter is equal to 
the mapped drive.): 

drive_letter:\drop_box\def_media_catalog.mc 

For printing via a network volume, skip to step 13 

11. Click Get. 

The FTP Login dialog box appears as illustrated in Figure 6. 

12. Enter the User ID and Password for the root account, and then click OK. 

F I G U R E  5  
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The paper catalog is copied from the SCS to the local PC. 

 
The paper catalog is copied to the default template path (C:\Program 
Files\Alto Imaging Common\Templates\9110), and renamed to include a 
numeric identifier. The numeric identifier allows individual paper catalogs to 

exist for multiple print engines. 

When changes are made to the paper catalog, use Get to update the local 
PC. This is not required when accessing the paper catalog via a network 
volume. 

13. For Spool Path type /var/spool/drop_box/images/ (be sure to 
include trailing slash). 

14. Select a Default Paper Size from the drop-down list. 

15. If desired, rename the Printer or Set as Default Printer (affects Custom Print 
only). 

16. Enter a Client ID, to identify originating PC when reviewing files listed in the 
SCS spool directory. 

17. Select Use Upper Case to name output files using upper case convention. 

18. Click Modify. 

19. Click OK. 

 
Select Use Upper Case when using SCS software later that v2.17. 

 

Custom Print functionality depends on using current UltraWare applications 
and the corresponding UltraIPP.dll.  For a list of the latest UltraWare 
components, including executables, and dynamic link libraries, visit 

http://www.altoimaging.com/AltoWeb/Products/Product Support/AltoVersions.htm 

If UltraIPP.dll is not installed, run the setup for UltraIPP from the Alto 
Imaging Technologies UltraWare CD-ROM. 

L 
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Printing with the Custom Print Interface 
The Custom Print Interface is available when you have an active file in Image 
Arranger or have selected a book in UltraPrint Client. Custom Print from 
UltraPrint Client includes a slightly different page selector in the user interface 

to designate the beginning page for each member of a multiple file print job (book). 
The UltraPrint Client interface is used throughout the remainder of this document. 

When using the Canon iR110 or Heidelberg Digimaster 9110 marking 
engine with SCS system software v4.xx, Custom Print provides advanced 
processing, taking advantage of new Document Structuring Conventions 

such as KDKChaptersAreSets, KDKChapters, and KDKPeOutput. Support for new 
accessories such as the Post Process Inserter is included. 

1. Select File from the menu bar, point to Custom Print, and then click on 
Digimaster 9110 Custom Print. 

The Digimaster 9110 Advanced Settings window opens as illustrated in 
Figure 7. 

2. Make the appropriate print settings. 

3. Click Print to submit the print job, click OK to save the template, or click 
Cancel to exit. 

When building a template from a newly scanned or created document, Save 
the document prior to invoking the Custom Print interface. If a document is 
named after the template has been defined, all settings will be lost when the 

document is opened. 

Print Settings 
� General. Profile information. 

Document Title. Displays name of the active document to which the 
Custom Print operation will apply 

Owner. Displays name of current user 

Charge Number. Enter charge number for print accounting function. 

Op Message. Enter operator message to be displayed at the OCI. Use of 
the Op Message requires the operator to manually release the print job. 

L 
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� Print Settings. Controls apply to the entire document.   

Printer. Select from multiple DM9110 printer definitions. Network and 
device-specific information is defined for each printer. 

More. Configure printers. See the section labeled Configure Printer 
earlier in the chapter. 

Number of copies. Set the number of copies to print. 

Padding. Set the number of copies to print as a subset within the total 
Number of copies. 

Plex Mode. Select simplex, duplex, or tumble. 

Collate. Produces sequential collated copies. The default is on. 

F I G U R E  7  
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Proof Set. Enables the job to be printed once and held until manually 
released by the operator. 

Set HKEYLocal Machine\Software\UltraIPP\9110\DefaultProofMode to 
a value of 1 to default to Proof Set on; set to a value of 0 to default to Proof 
Set off.  

WARNING: Using Registry Editor incorrectly can cause serious problems 
that may require you to reinstall your operating system. Problems resulting 
from the incorrect use of Registry Editor may be irreparable. Use Registry 

Editor at your own risk. 

Sets. Specifies that one or more ranges of pages will be treated and 
finished as a separate chapter. 

Output Option. Select output destination and finishing options. 

No Rendering (Arranger only). Drastically reduces printing time. Does 
not scale or dither images sent to marking engine. Ignores all Page Setup 
parameters except Headers/Footers. 

Set HKEYLocal Machine\Software\UltraIPP\9110\Default No Rendering 
to a value of 1 to default to No Rendering on; set to a value of 0 to default 
to No Rendering off.  

WARNING: Using Registry Editor incorrectly can cause 
serious problems that may require you to reinstall your operating 
system. Problems resulting from the incorrect use of Registry 

Editor may be irreparable. Use Registry Editor at your own risk. 

Trailer. Specifies how trailer page should be printed and paper type to be 
used. Select from On, Off, On Error Only, or First Page. 

Cover. Select Front or Back Covers and paper type to be used. Select from 
None, Print on Front, Print on Back, Print on Both Sides, Blank. 

� Page Level Settings. Controls apply to one or more selected pages.  Options 
selected here take precedence over selections made in Print Settings. 

Document Option includes all paper types read from the media catalog 
for the printer selected in Print Settings. Width, Height, Weight, Color, 
and Type are shown for the currently selected paper. 

Plex Mode. Select Simplex or Duplex. 

* 
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S E T T I N G  P A G E  I N F O R M A T I O N  

1. Select one or more pages in the page selector box.  You can select 
NONE, ALL, EVEN, ODD, FIRST, LAST, or specific page 
numbers by holding down the CTRL key and clicking on the page 
numbers displayed in the page selector box.  You can also select a 
range of pages in the display by selecting the first page, then 
selecting the last page in the range while holding the SHIFT key 
down. 

2. Select the media type for the selected page(s) from the Document 
Option drop-down list. 

3. Select Plex mode  (simplex or duplex) for the selected page(s). 

4. Repeat for other page exceptions. 

5. Click Print to submit the print job, click OK to save the template, 
or click Cancel to exit. 

Click Collapse to list only the files in the print job or Expand to 
list the files and pages in their entirety. 

Chapter Page. Indicates either the first page in chapter that should begin 
on an odd page, or a distinct chapter that should be finished differently 
from the method specified in the Print Settings section (the Sets 
parameter must be turned on). 

Output Option. Select output destination and finishing options for each 
selected chapter. 

Plex modes set in Print Settings apply to the entire document. If page level 
(Paper Information) plex settings are required, apply Print Setting plex mode 
for the entire document first, otherwise individual page plex mode settings 

will be lost. 

When pages containing conflicting Plex mode or Document Option settings 
are selected, the respective option lists are display as Mixed. 

 

� Blank Page. Inserts blank page (Insert). 

Insert After. Inserts blank page after currently selected page. 

Insert Before. Inserts blank page before currently selected page. 

Remove. Removes currently selected Blank Page. 

* 
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Remove All. Removes all Blank Pages. 

� Print Selection. Prints only those pages highlighted in the page selector. 

� Delete template on Cancel. Instructs Custom Print to delete the template 
when Cancel is selected. All Custom Print settings are reset. 

Job templates are saved whenever you click OK or Print from the Custom 
Print Interface. The template settings are reset anytime files or pages are 
repositioned, added, or removed; therefore a job should be built with all 

pages in place prior to applying print settings. UltraPrint Client saves a job template for 
the entire book (multiple files composing one print job). Individual job settings applied 
in Arranger are ignored when printing the same file from UltraPrint Client. The UltraPrint 
job template takes precedence over any individual file template that may exist. 

The Image On Demand Print choice from the Custom Print menu opens a 
dialog box allowing you to select the page range, print quality, copies, and 
other appropriate settings for direct image printing to certain printers which 

have generic TIFF interpreters such as the QMS ImageServer family.  For other 
supported TIFF printers, such as the Heidelberg DM9110, use the specific Custom 
Print module that matches the printer, or if none is present, print using the normal 
Windows driver (File | Print…). 

L 

L 



C U S T O M  P R I N T  U S E R  G U I D E  

13 

D E L E T I N G  T I F F  I M A G E  F I L E S  
Custom Print writes single-image TIFF files for each page printed to the marking 
engine. These images must be deleted periodically to preserve disk space on the SCS. 
The image files may be deleted manually at the Operator Control Interface, or from 
the local PC/Scan Server if printing via a network volume. 

Images printed via FTP must be deleted by the root account. 

 

Automating Deletion via a Network Volume 
The following example uses the Windows 2000/NT/XP AT command to remove 
TIF image files created by Custom Print (enter from command prompt where 
drive_letter is equal to the mapped drive). 

AT 0:00 /every:M,T,W,Th,F,S,Su cmd /c del drive_letter:\drop_box\images\*.TIF 

(12:00 am each day remove *.TIF with no confirmation) 

Scheduler service must be running 

 

Automating Deletion Using Cron 
The following example uses the UNIX Cron daemon to remove TIF image files 
created by Custom Print (Create as root, crontab -e starts ed. You could edit using 
another editor, but changes will not take effect until the operating system or the Cron 
daemon is restarted) 

0 0 * * * find /var/spool/drop_box/images -name "*TIF" -mtime +1 -exec rm -f {} \; 

(12:00 am each day find *.TIF older than 1 day, remove with no confirmation) 

 

0 
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C U S T O M  P R I N T  E X A M P L E S  
 
Paper Callouts from the Paper Catalog 
Figure 8 shows how to specify a paper type to be used for selected pages. Output 
option in the Print Settings section is set to Top. Plex mode is set to Simplex; Collate, 
and Proof are selected. Pages 3, 8, and 14 are selected and Tab is chosen from the drop 
down list labeled Document Options in the Page Level Settings section. 

The result is pages 3, 8, and 14 will be printed on the paper type called Tab. The 
document will be printed simplex, collated, and output to the Top exit. A proof will 
print requiring the operator to release the job if multiple copies are requested. 

Selecting a paper type listed in the paper catalog but not currently available in a paper 
drawer will result in a ‘paper mismatch’ notification at the Operator Control Interface. 

An Op Message will cause printing to hold until acknowledged, and is a 
handy way to notify the operator of a specific job requirement. 

F I G U R E  8  
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Chapters and Subset Finishing 
Figure 9 illustrates the use of the Set and Chapter Page options. Output option in the 
Print Settings section is set to Stapler (none, offset). Plex mode is set to Simplex; 
Collate, and Proof are selected In the Page Level Settings section, Page 5 is set as a 
Chapter Page and Output option is set to Stapler (front, offset). 

The result is pages 1 through 4 will not be stapled; pages 5 through 20 will be stapled. 
The document will be printed simplex, and collated. Each complete set will be 
delivered to the stapler, in offset stacks. A proof will print requiring the operator to 
release the job if multiple copies are requested. 

Multiple chapters may be defined and finished independently by selecting 
the start of each section and selecting Chapter Page. 

F I G U R E  9  
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Multiple Output Options 
In Figure 10, output to multiple destinations is illustrated. Output option in the Print 
Settings section is set to Stapler (both, offset), Plex mode is set to Simplex; Collate, 
Proof, and Sets are selected. Pages 3, 8, 14, 19, and 20 are selected and Tab is chosen 
from the drop down list labeled Document Options in the Page Level Settings section; 
page 19 is set as a Chapter Page, and Output option is set to Top. 

The result is pages 3, 8, 14, 19, and 20 will be printed on the paper type called Tab. The 
complete document will be printed simplex, collated, and output to the Stapler in 
offset stacks, but pages 19 and 20 will be delivered to the Top exit. A proof will print 
requiring the operator to release the job if multiple copies are requested. 

Only the first page of a ‘chapter’ is selected as a chapter page however, when 
multiple pages within a chapter are selected, the Chapter Page option 
appears with a grayed out selection mark indicating inclusion in the chapter. 

F I G U R E  1 0  
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Padding Multiple Sets 
In Figure 11, multiple sets are output in discrete groups. Number of copies is set to 5, 
Padding is set to 10. Output option in the Print Settings section is set to Stapler (none, 
offset), Plex mode is set to Simplex; Collate, and Sets are selected. Page 1 is set as a 
Chapter Page and Stapler (front, straight) is chosen from the drop down list labeled 
Output Options in the Page Level Settings section. 

The result is 50 document sets are output. Each set is stapled in the upper corner. 
Documents are offset in groups of 10. 

Use Padding to print single or multi-part forms in distinct pad amounts.  

F I G U R E  1 1  
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Custom Print Common Interface 
Support for other PostScript compatible printers is available through the Custom Print 
Common user interface and provides many of the same capabilities found in the 
traditional Custom Print interface. 

Custom Print Common is available only in UltraPrint Client and supports 
only PostScript compatible print drivers. Some printer specific options may 
not be available. 

The Custom Print Common interface prints to the printer currently selected for an 
UltraPrint Book or Page. The printer selected is shown on the Info Tab | Destination 
as displayed in Figure 12.  

L 
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S T A R T I N G  T H E  C U S T O M  P R I N T  C O M M O N  I N T E R F A C E  
 

1. Select File from the menu bar, point to Custom Print, and then click on 
Custom Print Common. 

The Custom Print Common Advanced Settings window opens as 
illustrated in Figure 13. 

2. Make the appropriate print settings. 

3. Click Print to submit the print job, click OK to save the template, or click 
Cancel to exit. 

When building a template from a newly scanned or created document, Save 
the document prior to invoking the Custom Print interface. If a document is 
named after the template has been defined, all settings will be lost when the 

document is opened. 

F I G U R E  1 3  

0 



A L T O  I M A G I N G  T E C H N O L O G I E S  

20 

Print Settings 
� General. Profile information. 

Document Title. Displays name of the active document to which the 
Custom Print operation will apply 

Owner. Displays name of current user 

Pages. Displays number of pages in book. 

� Print Settings. Controls apply to the entire document. 

Output Printer. Displays printer selected for the active document. 
Default Paper Size, Media, and Paper Source are also displayed. 

Number of copies. Set the number of copies to print. 

Collate. Produces sequential collated copies. 

Staple. Enables stapling. 

Sets. Specifies that one or more ranges of pages will be treated and 
finished as a separate chapter. 

Multi Job. For print jobs including mixed duplex modes. Only required 
for some Windows 9x/ME print drivers. 

Header/Footer. Overlays Headers or Footers as set in Page Setup. 

Color. Produces color output to color capable print devices. 

Plex Mode. Select simplex, duplex short-edge, or duplex long-edge. 

Paper Source. Select paper source from device-specific paper trays. 

� Page Level Settings. Controls apply to one or more selected pages.  Options 
selected here take precedence over selections made in Print Settings. 

Paper Size. Indicates image size including Width and Height, expressed 
as pixels. 

Plex Mode. Select simplex, duplex short-edge, or duplex long-edge. 
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S E T T I N G  P A G E  I N F O R M A T I O N  

1. Select one or more pages in the page selector box.  You can select 
NONE, ALL, EVEN, ODD, FIRST, LAST, or specific page 
numbers by holding down the CTRL key and clicking on the page 
numbers displayed in the page selector box.  You can also select a 
range of pages in the display by selecting the first page, then 
selecting the last page in the range while holding the SHIFT key 
down. 

2. Select the media type for the selected page(s) from the Document 
Option drop-down list. 

3. Select Plex mode  (simplex or duplex) for the selected page(s). 

4. Repeat for other page exceptions. 

5. Click Print to submit the print job, click OK to save the template, 
or click Cancel to exit. 

Click Collapse to list only the files in the print job or Expand to list the files 
and pages in their entirety. 

Chapter Page. Indicates first page in section that should be finished 
differently from the method specified in the Print Settings section. The 
Sets parameter must be turned on. 

Paper Source. Select paper source from device-specific paper trays. 

Media Type. Select media type from device-specific media types. 

Plex modes set in Print Settings apply to the entire document. If page level 
(Paper Information) plex settings are required, apply Print Setting plex mode 
for the entire document first, otherwise individual page plex mode settings 

will be lost. 

When pages containing conflicting Plex mode or Document Option settings 
are selected, the respective option lists are display as Mixed. 

 

� Blank Page. Inserts blank page (Insert). 

Insert After. Inserts blank page after currently selected page. 

Insert Before. Inserts blank page before currently selected page. 

Remove. Removes currently selected Blank Page. 

* 
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Remove All. Removes all Blank Pages. 

� Delete template on Cancel. Instructs Custom Print to delete the template 
when Cancel is selected. All Custom Print settings are reset. 

 
Job templates are saved whenever you click OK or Print from the Custom 
Print Interface. The template settings are reset anytime files or pages are 
repositioned, added, or removed; therefore a job should be built with all 

pages in place prior to applying print settings. UltraPrint Client saves a job template for 
the entire book (multiple files composing one print job). Individual job settings applied 
in Arranger are ignored when printing the same file from UltraPrint Client. The UltraPrint 
job template takes precedence over any individual file template that may exist. 

Job templates are printer specific. If the print device is changed and Custom 
Print Common is invoked, previous print settings will not be displayed. Any 
changes to Print Level or Page Level Settings will delete the template. If no 

changes are made, and the print device is changed to the previous selection the original 
print settings will be available. 
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Getting Help 
There are many sources of support available to ensure your experience with Alto 
Imaging Technologies UltraWare Software Suite is an enjoyable one. Here are several 
ways to obtain the help you need. 

M I C R O S O F T  W I N D O W S  D O C U M E N T A T I O N  
Refer to the documentation provided by the computer manufacturer or with the 
operating system. 

S C A N N E R  D O C U M E N T A T I O N  
Your scanner documentation provides complete information about the hardware. 

A L T O  I M A G I N G  T E C H N O L O G I E S  R E S E L L E R S  
Your local reseller (the one that helped you choose your UltraWare system) may be best 
equipped to help you. Your vendor has specially trained service technicians available to 
answer questions, and the equipment to analyze your problems. 

I N T E R N E T  
The Alto World Wide Web server provides access to technical reports, new product 
announcements, a trade show schedule, and other general information about Alto 
Imaging Technologies. 

If you have access to the World Wide Web, you can view the Alto Imaging 
Technologies web pages at http://www.altoimaging.com 

A L T O  C U S T O M E R  R E S P O N S E  C E N T E R  ( C R C )  
The Alto Customer Response Center (CRC) is available Monday through Friday, 8:00 
am to 5:00 pm, Central Standard Time. You can reach us by telephone at 
(251) 343-9339 (US). 

E-mail support questions to prefect@altoimaging.com 

If you do call for assistance, have the following information ready so our Customer 
Support Representatives can help you more quickly. 

� Your phone number, fax number, email and shipping addresses 

� A description of the problem 

� The version of the Alto Imaging application you’re using (from the Help menu 
choose the About command) 

� The printer, scanner, and computer models 

� The type and version of operating system you’re using 

http://www.altoimaging.com/
mailto:prefect@altoimaging.com
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� The amount of memory installed on your PC and printer 

� The printer interface you are using 

� The emulation you are using 

� Your printer type and any firmware version information you have 
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